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INTRODUCTION 
 
Welcome! This handbook provides a collection of 
resources to get you started finding, collecting, analyzing, 
and visualizing digital map data. It covers downloadable 
software like QGIS and Google Earth, as well as online 
tools like Google Maps Engine and GeoCommons.  
 
Internews – an international nonprofit whose mission is 
to empower local media – held a series of training 
workshops in Mongolia throughout 2014. More than 50 
people participated, primarily from civil society 
organizations engaged in monitoring extractive 
industries. This handbook is adapted from the training 
material developed and polished during these 
workshops.   
 
Many thanks to the workshop participants, the 
Mongolian Environmental Civil Council, Publish What 
You Pay Coalition, Internews staff, and all others who 
have contributed to this project! 
 
Samuel Maurer, Internews trainer 
PhD Student, University of California, Berkeley 
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PROJECT SCENARIOS 
 
What kind of project are you working on? 

 

A. I want to find maps and data 
that others have created 
 
There are many excellent sources online for 
maps and data about Mongolia. Most are 
operated by government agencies, 
universities, or international organizations. 
There are also some online maps with 
worldwide coverage, but the information they 
provide is more general. All these websites 
are listed in the Sources for Map Data 
Sidebar.a 
 
Another place to check is GeoCommons 
(http://geocommons.com), which is a 
community website where individuals and 
organizations can share map data with the 
public.  
 
What about finding satellite images? The best 
tool for this is the Google Earth app, which 
you can download to your computer for free 
(http://earth.google.com). Its historical 
imagery tool lets you compare satellite 
images across different points in time. 
Exercise 3 will introduce you to the key 
features of Google Earth.  

 

 
B. I want to make an interactive 
map and share it online 
 
This is a great way to get started with digital 
map-making. One of the best tools is Google 
Maps Engine (http://mapsengine.google.com), 
which lets you draw point markers, lines, and 
shapes on top of various base maps. You can 
choose between the traditional Google Map, a 
terrain map, or a satellite map. If you share a 
link to your map, others will be able to see the 
features you drew, including labels, 
descriptions, photographs, and so on. 
Exercise 2 will get you started with Google 
Maps Engine.  
 
Another similar tool is Mapbox 
(https://www.mapbox.com), which is based 
on Open Street Map data rather than Google 
Maps. To get started, sign up for a free 
account and look for the button labeled 
“Create Project.” Mapbox offers more styling 
options than Google Maps Engine, and also 
lets you import data files directly from your 
computer onto the web map. However, its 
base maps provide limited detail for the 
Mongolian countryside.

http://www.google.com/url?q=http%3A%2F%2Fgeocommons.com&sa=D&sntz=1&usg=AFQjCNHz_4h7mLfyAEDDUVLTzGtaA3dqBA
http://earth.google.com/
http://mapsengine.google.com/
https://www.google.com/url?q=https%3A%2F%2Fwww.mapbox.com&sa=D&sntz=1&usg=AFQjCNFob75vLJjYFVOZmAghotUrECpJkQ
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C. I want to open up files of map 
data  
 
The QGIS software program can open all the 
common formats of map data, but there are 
many simpler tools as well. (See Exercise 4 
for an introduction to QGIS.)  
 
Several websites can open map data from 
your computer, as long as the files aren’t too 
large. GeoJSON.io (http://geojson.io) can open 
KML and GeoJSON files, plus CSV 
spreadsheets that contain latitude-longitude 
coordinates. Mapbox (http://mapbox.com) 
can do the same. Ogre 
(http://ogre.adc4gis.com) will convert 
Shapefiles and other proprietary GIS data 

formats into GeoJSON format, which you can 
view on a map using one of the other 
websites. Please refer to the Data Formats 
Sidebar for more about this.  
 
The free Google Earth app 
(http://earth.google.com) is great for opening 
KML files and GPX files on your computer 
(GPX is the format generated by GPS 
receivers). Exercise 3 will get you started 
with Google Earth. Finally, if you want to 
open ArcGIS project files but don’t have that 
software package (it’s expensive), you can 
download a free viewer called ArcGIS 
Explorer 
(http://www.esri.com/software/arcgis/explor
er). 
 

 
D. I want to learn how to use GIS 
software 
 
Professionals analysts and cartographers use 
Geographic Information System (GIS) 
software to work with geographic data. This 
software has numerous features that are 
missing from simpler tools like Google Earth 
or web-based apps: image processing and 
statistics, ability to create printed maps, 
features for working with map projections, 
and the ability to work with many different 
file types, to name a few. 
 
Multiple software programs provide these 
same GIS features. The most common 
commercial software is ESRI ArcGIS 
(http://esri.com) and the most common open-
source software is QGIS (http://qgis.org). This 
brochure focuses on QGIS. See Exercise 4 for 
an introduction to it. If you can read some 
English, there is excellent documentation on 
the QGIS website: 
http://documentation.qgis.org. 
 

 
 
 

 
E. I want to see how different 
maps line up with each other 
 
One of the big challenges of using paper maps 
is matching locations from different maps. If 
there’s an animal habitat marked on one map 
and a road marked on another map, how do 
you figure out whether the road goes near the 
habitat? Most maps have design elements to 
help with this: coordinate grids, distance 
scales, and common features can all be used 
to estimate where a feature from one map 
would appear on another. 
 
Digital map software lets us align maps much 
more precisely, but the process can get 
complicated. The best is if you can find map 
data in an easily readable format like KML, 
GPX, or Shapefile. You can open all of these 
layers at once using software like Google 
Earth or QGIS. However, if your maps are 
image files – like scans or screenshots – you’ll 
have to georeference them first so the GIS 
software knows how they should be aligned 
with other maps. Exercise 7 will show you 
how to do this! 
 

http://geojson.io/
http://mapbox.com/
http://ogre.adc4gis.com/
http://earth.google.com/
http://www.esri.com/software/arcgis/explorer
http://www.esri.com/software/arcgis/explorer
http://esri.com/
http://qgis.org/
http://documentation.qgis.org/
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F. I want to create a printed map 
for a report, brochure, or poster 
 
The QGIS software has nice tools for creating 
printed maps. Exercise 6 walks you through 
this, but you should start with Exercise 4 if 
you haven’t used QGIS before.  
 
When you’re designing a map, it can be 
helpful to think of the map telling a story. 
What are you trying to communicate to the 
viewer? The first step is to choose what 
information is most important to include on 
the map. Perhaps it’s about weather patterns 
or industrial sites or soum statistics. Then, 
add some more features to provide 
geographic context: maybe roads or aimag 
boundaries or terrain.  
 
 

 
As you start applying graphical styles, make 
the more important features the boldest and 
easiest to read. Choose contrasting colors. 
Sometimes maps have so much background 
detail that it’s hard to make out what’s 
important — so think about whether there’s 
anything you can remove to make the map 
clearer. At the end, add titles, labels, and 
explanatory text. Add a map key explaining 
what the colors and symbols mean. Add a 
scale bar to show distance, and maybe even 
coordinate markings.  
 
Before printing your final map, test out the 
process to make sure the map will look sharp! 
Saving the map into PDF format is better than 
a picture format like JPG, GIF, PNG, TIF. Once 
something is in a picture format, it can’t be 
enlarged beyond a certain point without 
becoming blurry.

 

 
 
 

G. I want to share data files I have 
with the public 
 
Of all the web-based map making tools, 
GeoCommons (http://geocommons.com) is 
the best for sharing you data files with the 
public. If you post map data there, other users 
of the site can easily add it to their own 
GeoCommons maps, or download it to their 
computer. Here’s an example of Mongolian 
map data on GeoCommons, set up by the  
 
World Bank:  
http://geocommons.com/maps/204736 
 
You can also post data files directly to a blog, 
to Facebook, or to other websites. It’s best to 
ZIP the data into a single file (especially if it’s 
in Shapefile format), and you should tell 

people how to open them. Think about 
providing multiple data formats if it’s not too 
hard: Shapefiles for people using GIS systems, 
and KML for people using Google Earth or 
web-based mapping tools.  

 
 

 
 

http://geocommons.com/
http://geocommons.com/maps/204736
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SIDEBAR: SPECIAL TERMS (GLOSSARY) 
 
ArcGIS – the most common commercial GIS software 

 

Attributes – characteristics of a feature, like the name of a town or the population of an aimag 

 

Cadastre – a registry of land ownership and use rights, such as for mining licenses 

 

Coordinates – a pair of numbers specifying geographic locations relative to a particular reference 

point 

 

Feature – any item represented on a map, such as a city or a road or an aimag 

 

Georeferencing – specifying the coordinates of key locations on a scanned map so that it can be 

aligned with other layers of map data  

 

GIS (Geographic Information System) – professional software for working with geographic data and 

maps  

 

Interactive web map – an online map that lets you pan and zoom, and frequently provides other 

features like controlling layers and selecting features 

 

Latitude & longitude – the most common system of coordinates, specifying the location of each 

point on earth relative to the equator and the Greenwich Meridian.  

 

Layer (or map layer) – a group of features that can be manipulated separately from the rest of the 

map   

 

Legend – panel next to a map specifying what the colors and symbols mean 

 

Map data – the raw information behind what’s displayed on a map, often stored as a text-based list 

of coordinates, names, and other attributes 

 

Markers (or point markers) – a custom point added to a map, often marked with a pin icon 

 

Open-source – software that’s free to use and modify, often maintained by volunteers as an 

alternative to commercial software products 

 

Projection (or map projection) – one of various standardized methods for stretching the round 

globe to fit onto a flat map 

 

QGIS – the most common open-source GIS software 
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Raster data – map data made up of grids of pixels, such as satellite imagery 

 

Remote sensing – technologies for measuring the earth’s surface from far away, for example using 

satellites 

 

Satellite imagery – photographs of the earth’s surface taken from satellites 

 

Scale (or map scale) – ruler next to a map indicating the real-world distances  

 

Vector data – map data made up of points, lines, and polygon shapes 

 
 
 

SIDEBAR: SOURCES FOR MAPS AND DATA ABOUT MONGOLIA 
 
Ministry of Nature and Environment 
- Environmental Information Center - http://eic.mn 
- Information and Computer Center - http://www.icc.mn 
- GeoNetwork map database - MNE has lots of data offline as well, and this website provides indexes 
and contact information for staff - http://geodata.mne-ngic.mn:8080/geonetwork/  
 
Mineral Resources Authority 
- Main website - http://www.mram.gov.mn 
- Mining cadastre maps - http://cmcs.mram.gov.mn/CMCS#cid=5 
 
National University of Mongolia 
- Laboratory for Remote Sensing and GIS - http://spe.num.edu.mn/ 
 
Extractive Industries Transparency Initiative (EITI) 
- Data sharing project in partnership with the World Bank - 
http://english.eitimongolia.mn/map.shtml 
- Similar data posted to GeoCommons - http://geocommons.com/maps/204736 
 
United Nations Humanitarian Response open data project 
- Mongolia data for administrative boundaries, settlements, transportation -  
https://www.humanitarianresponse.info/node/all/datasets/locations/mongolia 
 
Open Street Map (a Wikipedia-style world map with excellent coverage of Ulaanbaatar) 
- Online map - http://www.openstreetmap.org 
- Downloadable data extracts - http://download.geofabrik.de 
 
Google Maps 
- Online map - http://maps.google.com 
 
 
 
 
 

http://www.google.com/url?q=http%3A%2F%2Feic.mn&sa=D&sntz=1&usg=AFQjCNGms1SvXF3QPcSA_FJCly4uacGP5Q
http://www.google.com/url?q=http%3A%2F%2Fwww.icc.mn&sa=D&sntz=1&usg=AFQjCNFwvk1X6SOAIEuGYSFwbjnyLCjnnA
http://www.google.com/url?q=http%3A%2F%2Fgeodata.mne-ngic.mn%3A8080%2Fgeonetwork%2F&sa=D&sntz=1&usg=AFQjCNGFplqv39akW-VNwLl_GwSYwzf91A
http://www.google.com/url?q=http%3A%2F%2Fwww.mram.gov.mn&sa=D&sntz=1&usg=AFQjCNHzzObWU-IyPtsGJKhFU5IQYmtAzQ
http://www.google.com/url?q=http%3A%2F%2Fcmcs.mram.gov.mn%2FCMCS%23cid%3D5&sa=D&sntz=1&usg=AFQjCNHPi5kq76I4tTVK_5B2_7DGU0p0RQ
http://www.google.com/url?q=http%3A%2F%2Fspe.num.edu.mn%2F6th-rsconf%2Fhtml%2Fabout_us.html&sa=D&sntz=1&usg=AFQjCNGH46isWE1alIZZM5X34KfqyO3aWA
http://www.google.com/url?q=http%3A%2F%2Fenglish.eitimongolia.mn%2Fmap.shtml&sa=D&sntz=1&usg=AFQjCNHYC27GvGWrmdfivK0sVj3KuIs5_A
http://www.google.com/url?q=http%3A%2F%2Fgeocommons.com%2Fmaps%2F204736&sa=D&sntz=1&usg=AFQjCNGETsLZPuUBMAQmczDo90Y3RLrbdw
https://www.google.com/url?q=https%3A%2F%2Fwww.humanitarianresponse.info%2Fnode%2Fall%2Fdatasets%2Flocations%2Fmongolia&sa=D&sntz=1&usg=AFQjCNGKbRPF087tVbkcQrA9pxMcv8c9AQ
http://www.google.com/url?q=http%3A%2F%2Fwww.openstreetmap.org&sa=D&sntz=1&usg=AFQjCNHHw1decxB47zV-3vPWPMthUDUHQQ
http://www.google.com/url?q=http%3A%2F%2Fdownload.geofabrik.de&sa=D&sntz=1&usg=AFQjCNGDTcEc9oUuK0f93jtBM8HCjvcu1w
http://maps.google.com/
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SIDEBAR: DATA FORMATS DEMYSTIFIED 
 
Shapefile (SHP) – This is the format used by GIS software to store complex vector data. One 
“shapefile” actually consists of several files with different extensions, all of which must be present. 
The file with the .SHP extension is the core file containing map geometry.  
 
KML – Common format for storing points, lines, and shapes with limited attributes. Easily opened 
with Google Earth, QGIS, or online tools. 
 
GeoJSON – Newer format developed for online tools. You can open it with QGIS. 
 
GPX – Format generated by GPS receivers. You can open it with Google Earth or QGIS. 
 
GeoTIFF – Common format for raster data like satellite imagery or scanned maps that you’ve 
georeferenced. You can open it with QGIS.  
 
CSV, XLS – Common formats for tables of data. If they include columns with geographic coordinates, 
you can plot the data on a map using QGIS or online tools.  
 
 
 

SIDEBAR: FURTHER RESOURCES 
 
 
MECC online reference material – <link to come?> 
Web links from training workshops – http://samuelmaurer.info/mongolia 
QGIS User Guide – http://documentation.qgis.org 
EcoLab GeoJournalism Handbook – http://geojournalism.oeco.org.br 
GeoCommons User Manual – http://geocommons.com/help/User_Manual 
StackExchange GIS Q&A website – http://gis.stackexchange.com  
 
 
 

EXERCISES 
 

Exercise 1: Using Interactive Online Maps  
 
Many websites provide interactive maps that users can pan and zoom to focus on a particular 
location. Often these maps also have other features like turning on and off map layers, selecting 
map features, and calculating distances. This exercise uses maps from the Ministry of Nature and 
Environment’s Environmental Information Center (EIC) to introduce these features.  
 
Skills you will learn: 
• Finding interactive environmental maps on the EIC website 
• Panning, zooming, and controlling the map interface 
• Measuring distance and finding latitude and longitude coordinates 
• Turning on and off layers of data and reading map keys 
• Saving pictures of a map 
 

http://samuelmaurer.info/mongolia
http://documentation.qgis.org/
http://www.google.com/url?q=http%3A%2F%2Fgeojournalism.oeco.org.br&sa=D&sntz=1&usg=AFQjCNGcPK0_saGRhOm8svZmKWymbtaN9g
http://www.google.com/url?q=http%3A%2F%2Fgeocommons.com%2Fhelp%2FUser_Manual&sa=D&sntz=1&usg=AFQjCNE0qnKJ--4Pxae1RQnDKUVnBCODBQ
http://www.google.com/url?q=http%3A%2F%2Fgis.stackexchange.com&sa=D&sntz=1&usg=AFQjCNHC4xB3BmghJCEEgQsbTUlXRZCGPA
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1) Open a web browser and go to http://eic.mn 

 
 
2) Choose “Гео-мэдээллийн сан / Geodatabase” from near the bottom of the list. Later you can try 
other maps, but this one includes all the features we will look at.  
 
3) The toolbar icons above the map let you control the map display. Try using the plus and minus 
tools to zoom in and out. Try using the hand tool to pan the map from side to side.  
 
4) Distance. The map scale ruler in the lower left indicates distances. How far is it from 
Ulaanbaatar to Darkhan?  
 
5) You can also use the ruler tool in the toolbar to measure distance, by clicking from point to point. 
What is the distance from the eastern tip to the western tip of Mongolia? The L-shaped ruler tool 
lets you measure area. 
 
6) Coordinates. The grid of lines on the map show latitude and longitude coordinates. The text 
below the map also tells the precise coordinates as you move the mouse around. What are the 
coordinates of Ulaanbaatar? What is another city that has the same latitude? What is at coordinates 
(41.7, 104.9)? 
 
7) Layer controls. You can show and hide layers of data using the controls to the right of the map. 
Zoom into an aimag and turn on soum boundaries and soum centers.  
 
8) Turn on the first vegetation layer. Turn on its legend by clicking the “rows of text” icon to the 
right of the layer name. You can also use the information tool from above the map (letter “i”) to find 
out the data categories for any point on the map.  
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9) Try exploring some of the different map layers, or other maps from the Ministry of Environment 
web site. 
 
10) Saving. Some of the maps have a toolbar button that lets you save a picture of the current view. 
You can also take a screenshot (of anything on the computer) by typing Alt + Print Screen. 
 
 

Exercise 2: Creating Interactive Online Maps 
 
This exercise introduces you to Google Maps Engine, which is an online app that lets you draw and 
label your own custom features on top of a normal Google Map. You can save the map, share it, and 
edit it collaboratively with colleagues. http://mapsengine.google.com/map 

 
Skills you will learn: 
• Navigating to Google Maps Engine and creating an account 
• Drawing pushpin markers, lines, and labels 
• Calculating distances and searching for locations 
• Changing the background map to a terrain view or satellite image 
• Saving and sharing the map 
• Exporting data to a computer file 
 
Sample map of Orkhon River area produced by workshop participants: 
https://mapsengine.google.com/map/viewer?mid=ztMvd-7q-B4w.kC-lxOACX-ow 
 
1) Open a web browser and go to http://mapsengine.google.com/map 
 

http://mapsengine.google.com/map
https://mapsengine.google.com/map/viewer?mid=ztMvd-7q-B4w.kC-lxOACX-ow
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2) Choose “Make New Map” and then sign into your Google account, or create a new account. If you 
have a login for Gmail, YouTube, or another Google service, you can use the same one here. 
 
3) If Google sends you to a dashboard page instead of to a map, try entering the original address 
into the menu bar again: http://mapsengine.google.com/map 
 
4) Drawing features. Use the pushpin tool (below the search bar) to add a pin to the map. Give it a 
name and description and click Save. Add some more pins. 
 
5) Each pin appears in a list to the left. If you move the mouse over a name in the list, a “paint can” 
tool appears and lets you change the color or shape of the pin. 
 
6) You can edit a pin name or location by clicking on it and then choosing the pencil tool in the 
window that pops up. 
 
7) Try using the line segment tool (below the search bar) to draw paths on the map. To end a path, 
click on the final point twice. You can also use the ruler tool to measure distances and areas, or the 
search bar to find locations.  
 
8) Changing the base map. Use the Base Map selector (on the left, below the list of pins) to change 
the background to a satellite image or terrain map. 
 
9) Sharing online. Give the map a title by clicking “Untitled Map” on the left and naming it 
something else. Now click the green “Share” button in the upper right. Next to the words “Private, 
only you can access,” click “Change” and then choose “Public on the web.” Click “Save” to return to 
the sharing window. Now you can copy the map’s link and send it to someone, or share it directly 
on Facebook.  
 
10) Saving features. The map is automatically saved to your Google account, and you can keep 
working on it when you return to Google Maps Engine (on any computer). To save the features as a 
computer file, click the folder icon under the map title and choose “Export to KML.” We will use this 
file in the next exercise.  
 
 

Exercise 3: Assembling Map Data with Google Earth  
 
Google Earth is an app that runs on your computer, and if free to download. It’s a great tool for 
working with map data in “KML” or “GPX” format, for example from GPS receivers. Google Earth 
also provides detailed satellite imagery from multiple time periods. http://www.google.com/earth/ 
 
 
Skills you will learn:  
• Using the controls to pan, zoom, and rotate the Google Earth satellite map 
• Drawing and labeling points, lines, and shapes 
• Editing features and measuring distances 
• Organizing map features into folders 
• Opening, saving, and exporting data 
• Searching for latitude-longitude coordinates copied from an EIC map 
 

http://www.google.com/earth/
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1) Download and launch the Google Earth application. 

 
 
2) Try zooming, panning, and rotating the map using the controls in the upper right. You can hide 
the photos at the bottom to make more room for the map. The “historical imagery” tool is the 
picture of a clock with a green arrow. Try clicking it and then using the sliding selector to look at 
older satellite images.  
 
3) Drawing features. Use the pushpin tool (along the top) to add a marker to the map. In Google 
Earth this is called a “Placemark.” After clicking the tool, drag the pin to the correct location, give it 
a name, and click “OK.” 
 
4) You can also draw lines and shapes using the tools to the right of the pushpin. To move or edit a 
marker, right-click on it and select “Properties.” You can measure distances using the ruler tool.  
 
5) Organizing data. On the left, there is a “Places” panel and a “Layers” panel. “Places” lists the 
features that you’ve added to the map, and “Layers” lists features from Google’s base map. Try 
turning off some Google layers to make the map less cluttered. 
 
6) It’s best to organize your markers into folders. Right-click on “My Places” and choose “Add -> 
Folder.” Name the folder and click “OK.” Drag the markers you created into the folder. 
 
7) Opening KML data files. Try opening a KML-format data file. If you completed Exercise 2, you 
exported one from Google Maps Engine. Go to “File > Open,” and find the KML file. In the “Places” 
panel, move it to a permanent folder.  
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8) Copying coordinates. In a web browser, go to http://mram.gov.mn and click the banner on the 
right to open the mining license cadastre map. Choose “Licenses.” Under “Area Name,” search for 
“Oyu Tolgoi.” Click the link in the “Code” column to see the map.  
 
9) Underneath the area description (on the right), click “Coordinates” to see the latitude and 
longitude boundaries of the permit area. Select the text of one of the coordinate pairs — for 
example, 106°47'31.48" E  42°58'31.35" N — and type Ctrl-C to copy it. Go back to Google Earth, 
paste the coordinates into the search bar by typing Ctrl-V, and click “Search.”  
 
10) Google Earth creates a temporary marker for the location you searched for. You can save it by 
clicking on the folder-with-arrow icon, between the “Search” panel and “Places” panel.  
 
11) Can you find the Oyu Tolgoi mine in the satellite map? (Hint: you will have to zoom out a bit, 
because it’s a large permit area.) Use the ruler tool to measure how far the mine is from the Small 
Gobi Protected Area. 
 
12) Try copying the coordinates for the other three corners of the permit area into Google Earth as 
well, and save the markers. Then you can draw a rectangle connecting the markers, indicating 
where the permit area is. You can delete the corner markers after you draw the rectangle. (Right-
click and choose “Delete.”) 
 
13) To change the color or opacity of the rectangle, right-click on it, choose “Properties,” and go to 
the “Style, Color” tab.  
 
14) When you click the pushpin tool to create a new marker on the map, you can type latitude and 
longitude coordinates directly into the box. Try finding some locations from another map, writing 
down their coordinates, and adding them in Google Earth. (You won’t need more than 4 or 5 digits 
after the decimal points.) 
 
15) Saving and exporting. All the features inside “My Places” will be saved in the Google Earth 
application. If you want to export a KML file with the locations of your markers, right-click on a 
folder and choose “Save Place As.” If instead you want a picture of what the map looks like, use the 
“Save Image” tool (above the map, near the printer icon).  
 
 

Exercise 4: Introduction to GIS, Part I 
 
GIS stands for “Geographic Information System,” and refers to the software systems that 
professionals use to create and analyze map data and design printed maps. These exercises uses 
software called QGIS, which is free to download and run on your computer. It’s the open-source 
equivalent of ArcGIS and includes all the same basic features, plus many advanced ones.  
http://qgis.org 
 
This exercises requires you to download a set of demo data files: <link to come?> 
 
Skills you will learn: 
• Loading vector map data like soum boundaries and roads 
• Using interface controls to pan and zoom  
• Activating, deactivating, and changing the order of layers 

http://qgis.org/
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• Adding labels and color styles using the “Properties” controls 
• Viewing tabular data using the “Attribute Table” controls 
 
1) Download, install, and launch the “QGIS Desktop” application. 
 

2) Loading map data. Click the “Add Vector Layer” button , then click “Browse,” and go to the 

“Map Demo Files” folder on the desktop. Choose the “boundary_aimag” folder and then the file 
inside with the same name, and click “Open.”  
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3) Click the “Add Vector Layer” button again, and load the “boundary_soum” layer, then “places,” 
and then “roads.” If you see a window asking you to choose a coordinate reference system, just click 
“OK” for now.  

 
 
4) Try using the hand tool and magnifying glass tools to zoom and pan around the map. If you zoom 
into Ulaanbaatar, you’ll see that the “roads” layer includes the full city street grid. 
 
5) Controlling layers. In the “Layers” panel (on the left), try using the check boxes to turn layers off 
and on. Try dragging the aimag layer above the soum layer, and then back. 
 
6) Adding labels. Double-click on the soum layer name to edit its properties. Choose the “Labels” 
tab on the far left, and find “Label this layer” at the top of the pane. Click the associated check box, 
choose the “Name” field, and then click “OK.” 
 
7) Applying styles. Double-click again on any of the layer names, and choose the “Style” tab on the 
far left. Just like there are multiple layers in the map, there are multiple potential styles for each 
layer, and we have to choose the correct one to edit. Find the box near the middle of the pane that’s 
labeled “Symbol Layers.” There will be an indented box in it saying either “simple marker” or 
“simple line” or “simple fill.” Click on this in order to see the correct options for changing the style.  
 
8) Can you figure out how to show thick aimag boundaries and thin soum boundaries, both at the 
same time? Give their text labels different styles too.  
 
9) Non-spatial data. Right-click on the aimag layer and choose “Open Attribute Table.” The layer’s 
geographic data is shown on the map (aimag shapes), and its non-geographic data (names, 
populations) is in the attribute table.  
 
10) We can color in the aimags according to their population. First, close the attribute table. Turn 
off the soum layer, so we can be sure to see the aimag layer. Now, double-click the aimag layer and 
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choose the “Style” tab. Find the drop-down menu that says “Single Symbol,” and change it to 
“Graduated.” For “Column,” choose “Population,” and for “Mode” (on the right), choose “Quantile 
Equal Count.” Click “Classify” (in the lower left) and then “OK.” The aimags with larger populations 
are colored darker.  
 
11) The “places” layer has a data field for “type” (like city, village, etc). Can you figure out how to 
use a similar technique to give different colored markers to each type of place?  
 
12) Save the QGIS project file by going to the “Project” menu and choosing “Save.” 
 
 

Exercise 5: Introduction to GIS, Part II  
 
This exercise is a continuation of the prior one.  
 
Skills you will learn: 
• Selecting data features by hand, by name, and by value 
• Identifying data features using selection tools and attribute tables 
• Selecting data with spatial queries 
• Saving new Shapefiles 
 
1) Open the “QGIS Desktop” application and load the aimag, soum, and road layers, if they are not 
already open. 
 
2) Selecting by hand. The first way to select features is by clicking them on the map. Choose the 

“Select Features” tool . Choose the name of the layer you want to select from, and then try 
clicking features on the map. When features are selected, they are highlighted in yellow.  
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 Now try choosing a different layer, and selecting its features the same way. You can use the 

“Deselect Features” tool  to remove the yellow highlighting.  
 
3) Selecting by data attributes. The second way to select features is using their data attributes. 
Right-click the soum layer and choose “Open Attribute Table.” Try click on the row numbers on the 
left, and see how the features you select are highlighted on the map.  

 
4) You can also create a database expression to select all the features that match a certain pattern. 
Choose the tool with an “E” from the top of the attribute table window. Click the “+” next to “Fields 
and Values,” and double-click on “Aimag_name.” Then click the “=” button. You will see the 
expression being built in the lower part of the window.  
 
5) Click the button labeled “Load Add Unique Values,” and then double-click on “Omnogovi.” Click 
“Select” at the bottom, and then “Close.” All the soums in Omnogovi should be selected on the map. 
 
6) Right-click the soum layer name and choose “Save Selection As.” We will create a new shapefile 
that contains just the Omnogovi soums. Chose format “ESRI Shapefile” and click “Browse” to choose 
a location for the file. It’s good to save the shapefile into its own folder. Also click the checkbox at 
the bottom to “Add Saved File to Map.” 
 
7) Selecting by spatial query. You can also select features based on their spatial relationship with 
data in other layers. As an example, we will select all the roads that pass through Omnogovi. First, 
choose the aimag layer, click the feature selection tool, and click on Omnogovi to select it.  
 
8) Go to the “Vector” menu and choose “Spatial Query.” (If it is not in the menu, go to the “Plugins” 
menu, then “Manage and Install Plugins.” Choose the “Installed” tab, and turn on the “Spatial Query” 
plugin.) 
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9) Build the following query: Select source features from “roads,” where the feature “intersects” 
reference features of “boundary_aimag,” and use the result to “create new selection.” Now click 
“Apply” and then “Close.” 
 
10) The roads passing through Omnogovi should have been selected, although it may be hard to tell 
until you save them as a new layer. Right-click on the roads layer and choose “Save Selection As,” 
and create a new shapefile with just the Omnogovi roads. 
 
11) Click the button to deselect all features, and try hiding the original soum and road layers, to 
only show Omnogovi aimag.  
 
 

Exercise 6: Creating Printed Maps   
 
The QGIS Print Composer provide an easy way to design maps for reports, posters, brochures, and 
other non-interactive uses.  
 
This exercises requires you to download a set of demo data files: <link to come?> 
 
Skills you will learn: 
• Creating a new print layout and adding your map 
• Adding titles, descriptions, legends, and map scales 
• Saving the map as a PDF for optimal printing 
 
1) Arrange the QGIS map window roughly as you would like it to appear on the printed map. 
 
2) From the “Project” menu, choose “Print Composer.” 

3) Use the “Add New Map” tool  to draw out a rectangle where the map will appear. You can use 

the “Move Item Content” tool  to move the map around in the frame.  
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4) Use the “Add New Label” tool  to add a title, and then go to the “Item Properties” panel on the 
right to enter text and make it larger.  
 

5) Add a legend  and map scale  to indicate distances and show what the colors and symbols 
mean.  
 
6) If you would like, add another label explaining the content of the map in more detail.  
 

7) Use “Export as PDF”  to create a file that will print sharply, or “Export as Image” to share the 
map on the web.  
 
 

Exercise 7: Map Projections and Georeferencing  
 
A map’s projection refers to the procedure that’s used to stretch the spherical globe out into a flat 
map. Each projection has its own tradeoffs: some maintain straight lines for north-south and east-
west but distort shapes, and it’s common for maps to show distances and shapes accurately in the 
center but distort features that are closer to the edge. The larger the area covered in a map, the 
more difficult to find an ideal projection.  
 
This exercises requires you to download a set of demo data files: <link to come?> 
 
Skills you will learn:  
• Changing the projection of maps in QGIS 
• Comparing common projections like Plate Carree, Mercator, and UTM 
• Viewing web maps from Google  or  OpenStreetMap within QGIS 
• Using the Georeferencer tool to align a picture of a map with other data 
 
1) Launch QGIS and load some of the demo shapefiles: aimags, soums, roads, etc.  
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2) Right-click on one of the layers and choose “Zoom to Layer Extent” to see the entire country.  
 
3) Map projections. From the “Project” menu, choose “Project Properties.”  
 
4) Make sure you are in the “CRS” tab on the left. Then click the check box at the very top, labeled 
“Enable On the Fly CRS Transformation.”  

 
5) Search for “48N” (no space), and choose the bottom-most result: “WGS 84 / UTM Zone 48N.” 
Click “OK,” and watch how the shape of the map changes. 
 
“WGS 84” refers to the current system for assigning latitude/longitude coordinates to points on the 
globe. “UTM” is a particular map projection, in other words a way of stretching the globe to fit on a 
flat map. “48N” is the version of it that’s most accurate for Mongolia’s region of the globe.  
 
6) Now we’ll try a different projection. Go back to “Project Properties” and search for the word 
“pseudo.” Choose the CRS called “WGS 84 / Pseudo Mercator” and click OK. This is the projection 
used for web maps like Google Maps or Open Street Map. 
 
7) When the data is in this projection, we can load Google Maps as a background layer. From the 
“Plugins” menu, choose “OpenLayers Plugin” and then “Add Google Streets Layer.” (If the Google 
map covers all your data layers, drag it to the bottom of the layer list. If “OpenLayers” is not in the 
menu, go to “Manage and Install Plugins” instead. Search for “OpenLayers” in the “Installed” panel 
to turn it on, or in the “Get More” panel to download it.) 
 
8) If you try projecting the map back to UTM 48N, the layers will no longer align properly. “Vector” 
data layers can be drawn in any projection, but “raster” image layers have a particular projection 
that can’t be easily changed. 
 
9) Remove the Google Maps layer before moving on. (Right-click and choose “Remove.”) 
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10) Georeferencing. Save an image from one of the Ministry of Environment maps that you’d like 
to bring into GIS. Or, download the demo image from http://samuelmaurer.info/vegetation.png 
 
11) Set the CRS in “Project Properties” to “WGS 84 / UTM Zone 48N.” Arrange the GIS window so 
that you can see the same part of the country that the image you’re importing shows. Then, from 
the “Raster” menu choose “Georeferencer.” (If it’s not there, go to “Manage and Install Plugins” and 
search for it in the “Installed” panel to turn it on. 
 

12) Click the “Open Raster” button  and find the map image you want to import. Give it the 
“WGS 84 / UTM Zone 48N” coordinate reference system. 
 

13) Use the “Add Point” tool  to click on the eastern tip of Mongolia in the image. Then click the 
“From Map Canvas” button, click on the same point in the GIS window, and choose “OK.” Repeat the 
process for at least three more points.  
 

14) Click the “Transformation Settings” button  to provide some more instructions. Good 
settings to start with are  transformation type “linear,” resampling method “cubic,” and 
compression type “LZW.” In the “Output Raster” box, choose a location to save the new version of 
the image. Be sure to click the check-box at the bottom labeled “Load in QGIS When Done.” 
 

15) Click the “Start Georeferencing” button . Choose “WGS 84 / UTM Zone 48N” one more time. 
Close the Georeferencer window, and the image will be aligned with your other GIS layers. 


